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PICKINGS FROM THE PRES.

Welcome back to all our students, tutors and
members. I do hope the festive season was just
great for you all and that 2004 will prove to be a
wonderful "learning computers" year for you. 
     Our project for Seniors Week in March will be
our Open Day on Monday, March 8 and I will
need as many volunteers as possible for that day.
Already I have many names, but I can still do
with many more, so if you have 2 hours free on
that day between 11 and 3 or 4, will you please
ring me or email me. There are positions vacant
for various jobs, not all computer skills but
general dogsbody jobs. 
     NOW the 'giveaway' (no it's not a bribe) if you
help on the day is a FREE lesson, so what more
could you want! 
     Hoping to hear from many! 

      Maxine 

Our Entertainer, Nick Gellert, from the Tuesday
class.

CLUB NEWS

Reminder.
Our first meeting for 2004 will be at 1.30 on
Wednesday, 28 January.
    Our speaker will be one of our own experts.
Treasurer, Graeme Gavin, who will demonstrate
some of the finer points of Excel.
    You should learn this. It is a handy tool for
keeping lists, budgets, accounts etc. And, of
course, keeping track of your huge share
portfolio.

***************
Our last meeting for 2003 was quite a departure
from usual.
    To add to the normal Christmas afternoon tea,
Nick Gellert, one of the Tuesday pupils, played
all the old favourites on the piano. Nick’s other
activity is an entertainer and certainly kept us
entertained during the afternoon.
     The audience was bit reluctant at community
singing. That’s not as popular as it was in the old
days. If you are as old as me, you will remember
sing at the movies – a la karioke.

**************
Our classes are still full with waiting list to join
almost gone.
There have been many enquiries over the holidays
so we look forward to another busy year.

***************
 

                The audience in a non-singing mood.



TIPS FROM TOPSY

For all Windows XP users Topsy is
recommending the Windows Made Easy
magazines. They are now up to Issue 31 and all
the recent issues have been explaining the various
aspects of Windows XP. It is worthwhile
borrowing them from the library and following
the different exercises to understand this
operating system.    

For those folk who have Office XP
installed. Issues 29, 30 and 31 have some good
exercises for you to understand this great word
processing programme.

SHORTCUT KEYS FOR OUTLOOK EXPRESS
Control + M     Opens Send and Receive window.
Control + Shift +F               Opens Find Message
                                                                  window.
Control + Shift + B               Opens Addressbook.
Control + U      Jumps to the next unread message
                                                               in mailbox
Control + F2       Opens message markup
                  i.e. interesting facts about the message.
Control + F3          Message source, handy if you 
    are not quite sure about where it has come from
Alt + Enter    View the Properties of the currently
                                                    selected message.

TABLES IN WORD
Try using Draw Table from the Table menu in
Word. You can make your own table to suit
your particular need for a specific purpose. Just
like a form and you TAB from column/cell to 
another.

ANOTHER FUN FEATURE OF WORD  -
DROP CAPS.

ake the first letter of a paragraph a
dropped capital (as at the beginning of
this sentence).   You can choose

whichever font you like – it makes the paragraph
look really good, check it out on some books.
Don’t forget rule of thumb when writing an
article/book/chapter – the first paragraph is not
indented.  Check this out in books.

DRAWING OBJECTS AND ADDING TEXT
TO THE OBJECT.
If you draw a rectangle square, oval  or circle and
you want to add text, just right click in the object
and Add text. Check out all the other Options
while you are there.

Topsy

INTERNET

The following interesting article appears on
Computers Associate’s website. 
    Our club has been using CA’s excellent
Antivirus program -VET98- since our beginning. 
As some of our members do not have VET 98 and
others have no access to the Internet, here it is for
all to read and enjoy:

Frances Ludgate, August 2002 (From Cyclops
Home Issue 42)
If it sounds too good to be true - assume it is - and
don't get caught out!
     Most hoaxes are relatively harmless - they
don't carry destructive payloads or destroy your
data, although, of course, they waste valuable
time and resources.
     However, there are some hoaxes that fall into a
different category - that of online fraud.
One of the most common of these is the "Nigerian
Letter Fraud" – Nigerian government official
trying to take a large amount of money out of the
country  - with your help. 
     There are numerous versions of this, all along
the same lines. The e-mail is quite lengthy,
reasonably well written and gives details about a
number of people who sound as though they
could be authentic. It states that you may incur
charges to set up a secure bank account  (which
will be refunded) and then asks that you send your
full name, phone number, fax number and bank
details "as the new beneficiary". 
     Hmmmm. Who would believe this? Well,
surprisingly, residents of the USA were taken for 
US$22 million in the last 3 months of 2001 on
this scan alone. The victims were asked to transfer
thousands of dollars to pay for administrative 
fees so that the full amount could be transferred to
the new account. Of course, it never was.
     A specific example of this, transferred to a
different country, is the e-mail from the 24 year
old student son of late Dr Smith Aliu Goodman,
financial adviser to the late president of Liberia -
Eloho Wilberforce Goodman. He asks for your
assistance to help he and his mother access a bank
fund of US$10.5 million - all completely
legitimate - hers of course!
     There are many other e-mail scams too - get
rich quick schemes, work at home "for only 8
hours a week", chain letters and so on. 
The difference between traditional scams and
Internet scams is not so much the  scam itself, but
the victims who fall for them. 

         Continued next month             The Surfer
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XP COMPATIBLE

“Compatible Hardware and Software” is an
information service provided by Microsoft on the
Internet that helps you decide which programmes
and hardware will work best with your computer.
Use it to preview products before you buy them,
or to check whether the products you have need to
be updated. The site is regularly updated, so you
can always get the most recent information.
       Search by manufacturer or product, or browse
through lists of software and hardware devices.
When you find the product you are looking for,
you can review the compatibility status provided
to determine if this product works with Windows
XP or if you need an update. In many cases,
Microsoft and other software and hardware
vendors have tested a product and rated its
compatibility with Windows XP. In other cases,
the product’s compatibility status is determined
through practical use. Microsoft encourages other
vendors to submit information about how well
their product works with Windows XP.
     To check, go to <http://www.microsoft.com>
and search for “Windows Logo Program”.
         …………………………………

INSERT A  PICTURE IN A MESSAGE

To insert a picture in an e-mail  message on
Outlook Express.
1. Click in the message where you want the

picture to appear.
2. On the Insert menu, click Picture and then

click Browse to find the image file.
3. Enter Layout and Spacing for the image as

needed.
Notes
• If you cannot select the Picture command,

make sure HTML formatting is turned on by
clicking Format in the message window and
then clicking Rich Text(HTML) . A black dot
appears by the command when it is selected.

• If message recipients are not able to view your
inserted images, click the Tools menu, and
then click Options. Click the Send tab, click
HTML Settings, and then make sure that Send
pictures with messages is selected. Then
resend your message.

• To insert a background picture , in the
message window, click on Format, point to
Background ,and then Picture. Click Browse
to search for the file you want to use.

MT
   

WOULD THEY KNOW WHERE TO FIND IT?

It is a constant dilemma for Executors of Estates
to be confidently able to say  that they have been
able to locate all of the documentation associated
with the Estate they are required to administer.
This  dilemma can arise as a result of a number of
different issues, for example, a person has spread
out their personal papers and placed them in a
variety of locations.
      It can also arise where documents have been
left in the safe custody of a bank or firm of
solicitors who are no longer at the location where
these documents were left.  There is no better
time than the present to make the effort to locate
your personal  papers.  These papers would
include things like your original Will, the Title
Deeds of your property, birth certificates,
marriage certificates, death  certificates of spouses
or children, Powers of Attorney, enduring
guardianship appointments, lists of shares and
other assets, details of superannuation, life
insurance policies etc.
       Your Executor will need to be able to locate
originals and copies of all of these documents
when their appointment becomes active.
       A useful example of this occurred when a
client of ours who had a great portfolio of shares
which he had listed in a comprehensive spread
sheet on his computer made this information of
little value when he did not disclose to anybody
the password for entry to the information.
      One of the important roles of an Executor also
involves the organising of the removal of a
deceased person’s remains  If you have been
appointed an Executor, we would advise that
some time be spent with the person who has made
the appointment discussing with  them , their
wishes in relation to their burial or cremation.
      Finally, we cannot emphasise the importance
of  your Will being up to date. In New South
Wales 40% of people die without  a Will or an up
to date Will.
      We want to encourage you as readers to take
the time to get your affairs in order so that the
trauma and messes that are often left to family
and friends can be dealt with now while there is
still an opportunity.

James Kelly - Owen Hodge. Lawyers.
      



THE CLUB
The Hurstville Seniors Computer Club was formed in April, 1998 to teach Seniors to use computers.
Clubrooms are in premises provided by Hurstville Council in the Hurstville Seniors Centre, and in an
Annexe in the MacMahon St building. Tuition is held during weekdays in an informal atmosphere -
cost being a minimum. We are an entirely voluntary operation, the aim being to help fellow Seniors.

  

BIRTHDAY BOYS AND GIRLS

   James Inglis 1-Feb
   Ken McRae 1-Feb
   Ella Dobbie 3-Feb
   Bill Redshaw 4-Feb
   Edna Greening 5-Feb
   Max Marvin 6-Feb
   Joyce Taylor 8-Feb
   Ron Hiland 9-Feb
   Leon Mannix 12-Feb
   Ron Leeds 13-Feb
   Betty Saltmiras 13-Feb
   Joan Storer 13-Feb

Margaret Alden 16-Feb
   Horrie Nicholson 16-Feb
   Noela Stewart 16-Feb
   Keith King 17-Feb
   Lance Peffer 18-Feb
   Phil Harrison 24-Feb
   Evelyn Rogers 27-Feb

MANY HAPPY RETURNS

E-MAIL LETTERHEADS

You can send your e-mails on your own
personal letterhead.

     In Outlook Express, go to the Tools
menu, then Options, Compose, Stationery,
and choose Create New. Browse to find
the letterhead or logo image, select it and
use the Stationery Layout  window to
specify its position on the page. Check the
font used on your letterhead and set the
font to match here as well.
     Give your stationery a name to be used
later. To use it in Outlook Express, click
on the down arrow next to the Create
                         Correspondence                       Hurstville Seniors Computer Club Inc.
                                                PO Box 173, HURSTVILLE  BC1481

Telephone - Clubroom,Queens Rd.                          9585 9184
Telephone - Annexe, MacMahon St                                    9580 5233
Telephone - Senior Citizens Hall                            9570 3297
Web Page -   www.homepages.ihug.com.au/~the_bounty/index.html
E-Mail - Clubroom                                     hhurstv2@bigpond.net.au
E-Mail - Annexe                                         the_bounty@ihug.com.au

Monthly Meeting                                 Hurstville Seniors Centre
                              91 Queens Road, Hurstville
                1.30pm, last Wednesday of the month   (except December)

Fees                 Joining Fee      $20
                        Annual Fee      $15
                        Training Fee    $4  per session

**********************

PATRON                                                   Councillor Mervyn Lynch
PRESIDENT                                             Maxine Gray    9785 2286

                    maxrose@compassnet.com.au
VICE-PRESIDENT                   George Thompson   9150 9377
                                                             ghompson79@yahoo.com.au

SECRETARY                                       Pamela Samuel     9522 6956
                                                             pamsam@compassnet.com.au
TREASURER                                        Graeme Gavin     9543 9095

                                                                            gmg1@tpg.com.au
**********************

TUITION IS IN ONE HOUR SESSIONS.
If you can’t attend your booking, please let your Tutor know.

Mondays                                                   Joyce Pickup    9533 4639
                                                                 joycepickup@hotmail.com
Tuesdays                                                 Maxine Gray     9785 2286
                                                            maxrose@compassnet.com.au
Wednesdays                                    Marie Thompson       9150 9377

                                                          ghompson79@yahoo.com.au
                                            No lessons on meeting day.
Thursdays                                              Betty Saltmiras    9567 6649
                                                                     bsaltmirs@bigpond.com
Fridays                                               Doreen Chisholm    9580 3218
                                                                  deechis@optusnet.com.au
Technical                                              John Chisholm     9529 5185
     Mondays at the Annexe                              chizim@pacific.net.au
Internet                                                      Frank Grosz     9554 8085
    Thursdays at the Annexe                        fjg123@optusnet.com.au
Maintenance  Crew - Queens Rd           Ted  Barnett        9502 2575
                                                                      barnett@froggy.com.au
                                                               Frank Grosz       9554 8085
                                                                   fjg123@optusnet.com.au

CHANGE OF ADDRESS. If you change your address, e-mail
or phone number, please inform the Treasurer (e-mail address above)
or your Tutor.

mailto:the_bounty@ihug.com.au
mailto:bertf@ozemail.com.au
mailto:swhitt@clubnet.net.au
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